
Advisor Workstation Training Manual:  
Working with Hypothetical  I l lustrat ions

Version 3.0 i

Overview  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  - 1

Training Scenario  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  - 1

Launching the hypothetical illustration tool 
from Advisor Workstation -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  - 2

Choosing the investments for a hypothetical illustration   -  -  -  -  - 3

Setting the time horizon and initial amount 
to be bought for each investment -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  - 4

Entering subsequent investments for a hypothetical illustration -  - 5

What if I need to make a withdrawal?   -  -  -  -  -  -  -  -  -  -  -  -  -  - 6

What if I want to transfer assets between investments? -  -  -  -  -  - 7

Setting up reinvestment and rebalancing options   -  -  -  -  -  -  -  - 8

Assigning the fees that will be charged 
for the hypothetical illustration -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  - 9

Determining the tax rate to be applied to the portfolio -  -  -  -  -  10

Selecting the report options  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  11

Generating the report(s) -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  13

Saving hypothetical illustrations   -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  -  13

Creating lists of hypothetical illustrations -  -  -  -  -  -  -  -  -  -  -  -  -  14

Updating the default settings for hypothetical illustrations   -  -  -  15



Advisor Workstation Training Manual:  
Working with Hypothetical  I l lustrat ions  
OverviewThis document will show you how to create and save hypothetical illustrations for your 
clients. The following topics are covered:

• How to launch the Hypothetical Illustration tool
• Choosing investments for the illustration
• Entering buy/sell criteria for an illustration
• Setting up reinvestment and rebalancing options
• Assigning fees to be charged for purchasing the funds and/or managing the portfolio
• Determining the tax rate to apply to the portfolio or securities
• Choosing the type of illustration you want to run (either for a portfolio, individual 

investments or a comparison hypothetical)
• Selecting reports you want to include (and making any changes to the report options that 

are available)
• Saving hypothetical illustrations
• Creating lists of hypothetical illustrations, and
• Updating the default settings for hypothetical illustrations.

Training ScenarioAlthough you can create hypothetical illustrations for individual securities, or to compare 
securities (e.g., mutual fund vs. mutual fund, or mutual fund vs. ETF), in this manual you will 
see how to create a hypothetical illustration for a client’s portfolio. 

 The chief difference between creating a hypothetical illustration for individual securities or a 
comparison vs. that for a portfolio is that you can rebalance securities only in a portfolio.

In this case, the sample portfolio will be for changing the investments in a traditional IRA 
worth $200,000 (using the earliest common time period for all holdings). The scenario also 
includes making subsequent annual investments. The portfolio will be rebalanced semi-
annually, and a 1% management fee will be applied. No taxes will be taken out.
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Launching the hypothetical illustration tool from Advisor Workstation
Launching the 
hypothetical illustration 
tool from  
Advisor Workstation

This section explains how to launch the hypothetical illustration tool. It appears in a 
window separate from Advisor Workstation. 

The most direct way to launch the hypothetical illustration tool is to go to the menu bar 
and select Tools…Hypothetical. This is the quickest way to launch the tool, but there 
are other methods which might also prove useful.

For instance, you can also launch the hypothetical illustration tool from the Research 
module. Simply select the investments you want to use in the illustration, then go to 
the menu bar and select Tools…Hypothetical. When the new window appears, the 
securities you selected will already be available on the Investments tab.

 You can also launch the hypothetical illustration tool by right-clicking on one of the selected 
securities and selecting Hypothetical from the menu that appears.

A further advantage can be had by launching the hypothetical illustration tool from the 
Clients & Portfolios module. By doing this, you will not only bring in the investments, but 
also the amounts assigned to each security.

From the Tools menu, 
click once on Hypothetical

After selecting a group 
of securities, right-click 
on one of them, then 
select Hypothetical from 
the menu that appears
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Choosing the investments for a hypothetical illustration
Choosing the 
investments for a 
hypothetical illustration

In this section, you’ll learn how to select investments for a hypothetical illustration. 
Note the following about creating a hypothetical illustration and searching for 
securities:

• You can include up to 40 securities in an illustration. 
• You can search for more than one security at a time (see the Note below), but you can 

search for items by name or ticker from only one security universe (mutual funds, 
stocks, ETFs, etc.) at a time.

• When searching on a portion of a security’s name, you must enter at least four 
characters. 

To create a hypothetical illustration and select investments for it, do the following:

1. On the Investments tab, use the Universe drop-down field in the upper left corner to 
choose the type of investments you want to search for. For this example, we’ll use the 
default option, U.S. Mutual Funds.

2. You can search for items by Name or Ticker symbol by entering those values in the 
search field. When you look for an item, the system searches for it by ticker symbol, 
name begins with, and name contains. Here, enter the following ticker symbols: 
agthx,amcpx,abndx,aepgx,aivsx,smcwx.

 Note: Separating items with a comma (agthx, contrafund) uses an OR methodology: find 
agthx OR contrafund. Separating items with a space (muni ca) uses an AND methodology: 
find funds that have “muni” and “ca” in the name.

3. Click Go.The investments you searched for appear in the Total Results box. 
4. Confirm that the items are the ones you searched for, then click Add All. The 

investments now appear in the FInal Results box.

5. Click the Buy tab at the top of the window.

Enter the ticker symbols
to search for, then click Go

To include this set of 
investments, click Add All

Items in this box will be 
included in the illustration
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Setting the time horizon and initial amount to be bought for each invest-
Setting the time horizon 
and initial amount to be 
bought for each 
investment

On the Buy tab, the default value for each fund’s Initial Investment is $10,000, and the 
default time period is for the trailing one-year period. Note that you can use the drop-
down fields at the top of this tab to manipulate the following:

• Currency (depending on which currencies your institution has decided to include)
• Method of inputting the value (dollars, shares or percentage)
• Total Value invested for the illustration (if entering allocations by percentage), and
• Time Period for the illustration. 

Do the following on the Buy tab:

1. Make sure the Currency field is USD. 
2. From the Allocate By drop-down field, select Percentage.
3. In the Total Value field, type 200,000.
4. In the Initial Investment fields, enter the following values:

5. To set the Time Period for the hypothetical illustration, click the Time Period drop-down 
field in the Apply to All row and choose Trailing 3 Yr. All other rows will automatically 
use this start date.

6. Click the Advanced Buy/Sell tab at the top of the window.

Investment Percentage Amount

American Funds Amcap A 22

American Funds Bond Fund of Amer A 15

American Funds EuroPacific Gr A 10

American Funds Grth Fund of Amer A 15

 American Funds Invmt Co of Amer A 20

American Funds Smallcap World A 18

Select this option 
from the Time Period
field in the Apply to All row.
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Entering subsequent investments for a hypothetical illustration
Entering subsequent 
investments for a 
hypothetical illustration

On the Advanced Buy/Sell tab, we’ll indicate that in addition to the starting amount of 
$200,000, the client will also invest an additional $500 in each fund every quarter. 

In the Subsequent Invest/Withdraw area, do the following in the Apply to All row:

 Alternatively, you could enter different values in each row for the securities.

1. In the Type field, confirm that Invest is selected.
2. In the Amount field, type 500.
3. From the Frequency field, select Quarterly. 
4. From the Month End field, select 3. This means the contribution will be made at the end 

of the third month of the quarter.

Enter the information 
for subsequent investments
for all securities in this row
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What if I need to make a withdrawal?
What if I need to make a 
withdrawal?

To make regular withdrawals from a hypothetical illustration, select Withdraw or 
Withdraw % from the Type field in the Apply to All row.

By default, the system will begin to make these subsequent investments or 
withdrawals based on the Start Date you entered. If you want to illustrate delaying the 
contribution (or withdrawal) for a period of time, do the following in the investment’s 
row:

1. From the Type field, select Custom. A new window appears.
2. You can either use the Add Systematic Transaction fields, and alter the Begin date and 

End date as necessary, or you can type the value to be invested or withdrawn directly 
into a monthly field. Note that investments are entered as positive numbers, and 
withdrawals are entered as negative numbers.

Use these fields to add 
systematic investments to or 
withdrawals from a portfolio.
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What if I want to transfer assets between investments?
What if I want to 
transfer assets between 
investments?

Although we will not use this in our scenario, it is possible to transfer assets from one 
investment to another. One scenario in which you might want to do this is to allocate a 
majority of assets first to a fixed-income fund, and then gradually move money to an 
equity fund. This dollar-cost averaging process might appease conservative investors 
who are leery of putting a large sum of money into a stock fund all at once. 

To transfer assets from one investment to another, do the following:

1. Click the Add/View Transfer button. The Transfer dialog box appears. 

2. In the From field, select the investment you want to move money from.
3. In the To field, select the investment you want to move money to.

4. Fill in the remaining fields with the amount of money you want to move (by dollars or 
percentage), how often the money should be transferred, and when the transfer should 
begin and end.

5. If necessary, click in the next row to add an additional transfer scenario.

Click this button 
to open the 
Transfers dialog box

Scroll right to see 
additional fields
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Setting up reinvestment and rebalancing options
Setting up reinvestment 
and rebalancing options

The next step is to rebalance the portfolio, to ensure the assets remain in their proper 
allocation. 

 Remember that rebalancing a portfolio will incur loads and redemption fees, unless you elect 
to exclude these on the Fees tab.

To rebalance a hypothetical illustration, do the following:

1. Click the Reinvest/Reb tab at the top of the window. 
2. From the Rebalance Frequency drop-down field at the top of this step,  

choose Semi-Annually. 
3. You can set a new rebalancing schedule for the funds if you like, or you can use the initial 

investment allocation. 

4. To enter a threshold the portfolio must reach before rebalancing occurs, click in the 
Rebalance Threshold % +/- field and enter a percentage.

5. To rebalance to different asset allocations over time, click the Subsequent Allocations 
button. The Subsequent Allocations dialog box appears.

6. From the Allocation Update Frequency drop-down field, select Annually.

 You can select Custom from the Allocation Update Frequency drop-down list to enter up to 
15 allocations with custom dates. You must use month-end dates.

7. In the fields below, you can enter new allocation values.
8. Click OK to return to the Reinvest/Rebalance tab. 

Select Semi-Annually 
from this drop-down list

Select Annually 
from this drop-down list
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Assigning the fees that will be charged for the hypothetical illustration
The other aspect of this step is to decide whether dividends and capital gains will be 
reinvested in this portfolio. The default option is to reinvest these monies, and we will 
leave this setting as is. If the client did not want to reinvest the dividends and capital 
gains, and instead wanted to take them as distributions, you could select No from the 
drop-down field for each of those columns.

Assigning the fees that 
will be charged for the 
hypothetical illustration

Here are some factors to consider when determining the fees for a hypothetical 
illustration:

• Will the fees be paid by selling off shares from the portfolio, or will the client pay the 
fees our of their own pocket?

• Will the fees be paid at the beginning of a time period, or at the end of one?
• If the fees are to be paid by selling off shares of the portfolio, should the cash position 

be used before equity or fixed-income holdings are used?
• If you elected to rebalance the portfolio, are you going to apply transaction fees for the 

rebalancing? 
• Are you going to use the Standard front-end loads for the funds, or enter a custom 

charge?
• Is there a Letter of Intent for future purchases to consider?

 To see the front-end sales charges and LOI period for a fund, scroll to the right on the Fees 
tab and click the View link in the Standard Fee Schedule column.

You can use these fields 
to illustrate the effects of 
reinvesting back into the 
portfolio, or taking distributions

This window appears when 
you click the View link in the 
Standard Fee Schedule column
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Determining the tax rate to be applied to the portfolio
To set the fees for the portfolio, do the following:

1. Click the Fees tab at the top of the window. Since we’ll be using the same rate for each 
fund, you can enter all of the following values in the Apply to All row.

2. In the Annl Fee % field, type 1.00. 
3. From the Frequency field, click the drop-down arrow and select Quarterly. (This means 

that each quarter, 25 basis points will be applied to the portfolio to determine what fees 
will be charged for managing the portfolio.).

4. To avoid charging both an annual fee and the load for a fund, click the Load Type drop-
down field, select Custom and ensure the Amount field is 0.

Determining the tax rate 
to be applied to the 
portfolio

To assign the tax rate for the hypothetical illustration, do the following:

 Illustrations that contain subaccounts for a variable annuity will not be able to apply taxes.

1. Click the Taxes tab at the top of the window. 
2. From the Filing Status drop-down field, select Married Filing Jointly. 
3. In the Taxable Income field, type 110,000. 
4. Click anywhere on the screen. Note that the Federal Income field automatically updates 

with the correct value. You can overwrite this value, or any of the other tax fields, if 
necessary.

Enter the fee information 
in the Apply to All row.

You can overwrite the values 
in these fields, if necessary
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Selecting the report options
Selecting the report 
options

The final tab in the hypothetical illustration tool requires the following decisions:

• What type of hypothetical illustration are you going to run: Individual Holdings, Portfolio 
or Comparison?

• What reports will you include along with the hypothetical illustration?
• How frequently will returns be displayed for the hypothetical illustration? 

To set the report options, do the following:

1. Click the Report Options tab at the top of the window. 
2. From the Report Type area, make sure the Portfolio option button is selected.
3. In the cover page area, fill in the fields for Client Name and Prepared By.
4. Click the check box for each report you would like to include along with the hypothetical 

illustration. Each report is briefly described in the table below. 

 The reports you see in your version of the application will be those your institution has 
subscribed to. They might differ from those listed below.

 *These reports are available only when you run a Portfolio hypothetical. They are not 
available for Individual Holdings or Comparison hypothetical illustrations. 
 
**You need to select the time period (available at the bottom of the Report Option tab) to be 
used with these reports.

Report Name Description

Distribution and 
Withdrawal Summary

This report shows you the dividends, capital gain distributions and withdrawals that were 
either taken from or reinvested back into investments over the hypothetical period. 

Portfolio X-Ray*
This report details a portfolio’s holdings in terms of broad asset class exposure, style box 
breakdown by Equity and Fixed-Income holdings, and regional exposure.

Portfolio Snapshot* This report shows both holdings and performance information for a portfolio of investments.

Stock Intersection*
This report shows you the overlap for the top 25 net stock holdings in a portfolio, ranked by 
percentage of portfolio net assets.

Risk/Reward 
Scatterplot**

The report shows the standard deviation and mean return for each holding, as well as the 
portfolio itself, and the benchmark. In contrast to the Risk/Reward Scatterplot on the 
Portfolio Snapshot report, this version provides a numbered and color-coded key to 
understand which dot on the scatterplot reflects each holding.

Correlation Matrix**
This report demonstrates the relationship of return patterns among investments. If a strong 
positive correlation is present among all holdings, you might not be getting true 
diversification for the portfolio. Up to 20 holdings can be shown here.

Rolling Returns**
This report shows the returns for each holding in the illustration, and it reflects the time 
period for the illustration as well. The largest positive and negative return period is shaded 
gray on the chart.

Total Annual Return
This report shows the total return (after fees and expenses) for the trailing 12 months for 
each holding. Up to 10 securities (selected based on alphabetical order) can be displayed.

Investment Details This one-page report summarizes the information for each investment in the portfolio.

Price and Distribution 
Report

This report shows you the change in NAV for a fund going back to its inception date (or the 
earliest price available in Morningstar’s database. You can also see the dividend and capital 
gain distributions for a fund on this report.

Disclosure Materials This material must be included in order for the illustration to be FINRA compliant.
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Selecting the report options
5. From the Display Return on Report field, select Semi-Annually. This will allow us to see 
returns every six months for the portfolio.

6. Leave the boxes checked for Include Net Amount Invested and Include 
Benchmark. The default benchmark is the S&P 500 Total Return index, but you can 
change this. The Include Net Amount Invested field will include a third line on the 
Portfolio Summary hypothetical illustration chart. The first line shows the performance of 
the hypothetical, the second shows the performance of the benchmark, and the third is 
the total number of dollars the client has invested over time.

 Note: if you did not make any subsequent investments in the hypothetical, it is not necessary 
to check the Net Amount Invested box, because this will simply produce a flat line on the 
hypothetical return graph at the amount of the initial investment.

Review all of the 
options here before 
generating the report.
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Generating the report(s)
Generating the report(s)Now that all of the variables for the illustration have been entered, click the Generate 
Report button at the top of the window. The reports will appear as a PDF in a separate 
window.

Saving hypothetical 
illustrations

You can save a hypothetical illustration at any point as you are creating it. The 
illustration will be saved to the main Advisor Workstation window. From the 
Hypotheticals tab, you can double-click the name of a saved hypothetical to open it for 
editing. 

To save a hypothetical illustration, do the following:

1. Click the Save button at the top of the screen. The Save dialog box appears.
2. Type a name for the hypothetical illustration.

 If you would prefer to save the illustration locally in an encrypted XML file, click the Save 
Locally button instead. You will be prompted to choose a name and destination for the file.

3. Click OK.

Click this button to 
generate the reports.

Click this button to save 
a hypothetical illustration.

Type a name for the illustration 
here, then click OK
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Creating lists of hypothetical illustrations
Creating lists of 
hypothetical 
illustrations

You can organize the hypothetical illustrations you have saved online into a series of 
lists. (This is not available for illustrations you saved locally.) 

To create a list of saved hypotheticals, do the following:

1. From the Hypotheticals tab in Advisor Workstation, click to select the hypothetical 
illustrations you want to include in a list. 

 You can use <SHIFT>+click to select multiple consecutive records, or <CTRL>+click to 
choose multiple non-consecutive records.

2. From the menu bar select File…New…List, or right-click and select New…List. The 
List dialog box appears. The records you highlighted appear in the Total Search Results 
area.

3. Click Add All to move the saved hypotheticals from the Search Results area to the Items 
Selected for List area.

4. Click Save at the top of the dialog box.
5. In the Save dialog box, enter a name for the list.

6. Click OK, then close the List dialog box.
7. In the left-hand navigation pane, click once on the Hypo Lists item under the 

Hypotheticals User Files folder to see the list you’ve just created.
8. To see the items that comprise a list, double-click its name. The List dialog box appears 

again. You can also add or remove saved hypos from the list with this dialog box.

Enter a name for the list 
and click OK
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Updating the default settings for hypothetical illustrations
Updating the default 
settings for hypothetical 
illustrations

If you find yourself using the same inputs (initial investment, time horizon, rebalancing, 
fees, etc.) for a hypothetical illustration over and over again, you can save those 
settings as your default options.

To update the default settings for a hypothetical illustration, do the following:

1. From the File menu, select Preferences. The Preferences dialog box appears.

2. At the top of the window, click New. The Save dialog box appears.
3. Type a Name for this set of preferences, then click OK.

Click the File menu, 
then select Preferences

Type a name here, 
then click OK
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Updating the default settings for hypothetical illustrations
4. Under Hypothetical Illustrations, select a main area (Buy, Advanced Buy/Sell etc.) 
from the left-hand navigation panel, then update the default preferences for each area.

5. Click Save to save your preferences.
6. To select your set of preferences while working in the hypothetical illustration tool, click 

the Preference drop-down field at the top of the window and make a selection.

Click each option here 
to change your default 
settings for each section 
of the hypothetical illustration.

Click this drop-down field 
and make a selection to use 
a set of preferences you have created
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